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Document Change Record
This page records changes to this document. The document was
originally released as Revision 001.

Version Revision
Number Letter

Date

Description of Change

006

005

004

003

002

A

A

A

10/2008

12/2006

1/2006

8/2005

6/2005

Corrected the procedure describing how to
upgrade the firmware on the scanner.

Converted document to new template/

style.

Added information on how to connect as a
keyboard wedge using the Keyport
Bluetooth application.

Updated part numbers and model
numbers to support the RoHS compliant
SF51.

Added information to support firmware
version 1.2 including these features:

Additional trigger mode settings, level
trigger mode enhancements, and support
for the Trigger Timeout and Turn Off
After Good commands.

Support for the EAN.UCC Composite, and
TLC 39 bar code symbologies, the Code
128 FNC2 control character, the code
mark Symbology ID setting, and the
Matrix 2 of 5 ChinaPost start/stop code.
Data editing.

Added references to Keyport Lite, a
keyboard wedge application supported on
the SF51 for English QWERTY keyboards.

Removed references to the HID keyboard
profile, which is currently not supported on
the SFS1

Added information to support firmware
version 1.1 including these features:

HID keyboard profile
SF51 Firmware Upgrade Utility
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Before You Begin

Before You Begin

This section provides you with safety information, technical
support information, and sources for additional product
information.

Safety Information

Your safety is extremely important. Read and follow all warnings
and cautions in this document before handling and operating
Intermec equipment. You can be seriously injured, and
equipment and data can be damaged if you do not follow the
safety warnings and cautions.

This section explains how to identify and understand warnings,
cautions, and notes that are in this document.

A warning alerts you of an operating procedure,
practice, condition, or statement that must be
strictly observed to avoid death or serious injury

Warning ¢4 the persons working on the equipment.
A caution alerts you to an operating procedure,
practice, condition, or statement that must be
strictly observed to prevent equipment damage or
Caution

destruction, or corruption or loss of data.

Note: Notes either provide extra information about a
topic or contain special instructions for handling a
particular condition or set of circumstances.

SF51 Cordless Scanner User’s Guide ix



Before You Begin

Global Services and Support

Warranty Information

To understand the warranty for your Intermec product, visit the
Intermec web site at www.intermec.com and click Support >
Returns and Repairs > Warranty.

Disclaimer of warranties: The sample code included in this
document is presented for reference only. The code does not
necessarily represent complete, tested programs. The code is
provided “as is with all faults.” All warranties are expressly
disclaimed, including the implied warranties of merchantability
and fitness for a particular purpose.

Web Support

Visit the Intermec web site at www.intermec.com to download
our current manuals (in PDF). To order printed versions of the
Intermec manuals, contact your local Intermec representative or
distributor.

Visit the Intermec technical knowledge base (Knowledge Central)
at www.intermec.com and click Support > Knowledge Central
to review technical information or to request technical support
for your Intermec product.

Telephone Support
In the U.S.A. and Canada, call 1-800-755-5505.

Outside the U.S.A. and Canada, contact your local Intermec
representative. To search for your local representative, from the
Intermec web site, click About Us > Contact Us.

Service Location Support
For the most current listing of service locations, click Support >
Returns and Repairs > Repair Locations.

For technical support in South Korea, use the after service
locations listed below:

AWOO Systems

102-1304 SK Ventium

522 Dangjung-dong

Gunpo-si, Gyeonggi-do Korea, South 435-776
Contact: Mr. Sinbum Kang

Telephone: +82-31-436-1191

E-mail: mjyun@awoo.co.kr

b'¢ SF51 Cordless Scanner User’s Guide
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IN Information System PTD LTD

6th Floor

Daegu Venture Center Bldg 95

Shinchun 3 Dong

Donggu, Daegu City, Korea

E-mail: jmyou@idif.co.kr or korlim@gw.idif.co.kr

Who Should Read This Manual

The SF51 Cordless Scanner User’s Guide provides you with
information about the features of the SF51. This guide is written
for the person who is responsible for installing, configuring,
maintaining, and troubleshooting the SF51.

Before you configure the SF51, you should be familiar with
your network and general networking terms, such as IP address.
You should also have a working knowledge of Bluetooth
communications.

Related Documents

The Intermec web site at www.intermec.com contains our
documents (as PDF files) that you can download for free.

To download documents

1 Visit the Intermec web site at www.intermec.com.
2 Click Support > Manuals.

3 In the Select a Product field, choose the product whose
documentation you want to download.

To order printed versions of the Intermec manuals, contact your
local Intermec representative or distributor.

Patent Information

Product is covered by one or more of the following patents:

4,766,300, 5,548,108; 5,912,452; 4,882,476; 5,550,362; 5,923,022;
4,894,523;5,550,364; 5,936,224; 4,953,113; 5,565,669; 5,949,056;
4,970,379, 5,572,007; 5,969,321; 4,988,852; 5,576,529; 5,969,326;
5,019,699; 5,594,230; 5,979,768; 5,021,642; 5,598,007; 5,987,192;
5,038,024; 5,608,578; 5,992,750; 5,081,343; 5,616,909; 6,003,775;
5,095,197; 5,619,027; 6,012,640; 5,144,119; 5,640,001; 6,016,960
5,144,121; 5,659,431; 6,018,597; 5,182,441; 5,672,860; 6,024,289
5,187,355;5,684,290; 6,034,379; 5,187,356; 5,719,678; 6,036,093;
5,216,233; 5,729,003 6,039,252; 5,216,550; 5,742,041; 6,064,763
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5,218,191;5,761,219; 6,095,422; 5,233,172; 5,764,798; 6,097,839;
5,241,488;5,777,308; 6,102,289; 5,243,602; 5,777,309; 6,102,295;
5,258,606; 5,777,310; 6,119,941; 5,288,985; 5,786,583; 6,128,414;
5,308,966; 5,798,509; 6,138,915; 5,342,210; 5,798,513; 6,149,061;
5,359,185; 5,804,805; 6,149,063; 5,389,770; 5,811,776; 6,152,370;
5,397,885; 5,811,777; 6,155,490; 5,414,251; 5,818,027; 6,158,661;
5,416,463; 5,821,523; 6,164,542; 5,442,167; 5,834,749; 6,164,545;
5,464,972; 5,837,987; 6,173,893; 5,468,947; 5,841,121; 6,195,053;
5,468,950 5,842,070; 6,234,393; 5,477,044; 5,854,478 6,234,395;
5,486,689; 5,862,267; 6,249,008; 5,500,516; 5,869,840; 6,328,214;
5,502,297; 5,873,070; 6,330,975; 5,504,367; 5,877,486; 6,345,765;
5,514,858; 5,878,395; 6,356,949; 5,534,684; 5,886,338; 6,367,699;
5,536,924; 5,895,906; 6,375,075; 5,539,191; 5,902,987; 6,375,076;
5,541,419; 5,902,988; 6,435,411.

There may be other U.S. and foreign patents pending.
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Learning About the
SF51

Use this chapter to familiarize yourself with
the SF51 Cordless Scanner. This chapter covers
these topics:

Introducing the SF51 Cordless Scanner
What’s New?

Using the Battery

How to Turn On the SF51
Understanding the Lights
Understanding the Beeps

Scanning Bar Codes

Using Vibrate Alert



Chapter 1 - Learning About the SF51

Introducing the SF51 Cordless Scanner

The SF51 Cordless Scanner is a small, rugged handheld scanner.

It is a lightweight, ergonomically designed scanner that uses a
Bluetooth™ radio for RF communications.

The SF51 includes these features:

Scanner C\// Scan button
% Intermec
Ready-to-Work
indicator

£ Magnetic connector

SF51 Cordless Scanner

This device contains permanent magnets that
A can generate magnetic fields of greater than 10 gauss.
Caution should be used by anyone with a Pacemaker,
Implantable Cardioverter Defibrillator (ICD), or Heart

Failure Device. Check with your doctor for detailed
information before using this device.

Warning

What'’s New?

This revision of the user’s guide includes corrections to the
firmware upgrade procedure.

Using the Battery

The SF51 uses a lithium-ion battery as its main power source.
You need to fully charge the battery before you can use the SF51.

SF51 Cordless Scanner User’s Guide
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present a fire or chemical burn hazard if it is mistreated. Do

not disassemble it, heat it above 100°C (212°F) or incinerate
it.

g The lithium-ion battery pack that is used in this device may

Warning

Charging the Battery

Make sure you fully charge the battery before you start using the
SF51.

To charge the battery

* Place the SF51 in the 1-bay charger (Model 074645) or the
4-bay charger (Model 074646). A fully discharged battery
charges to 100% capacity in approximately 3 hours.

It may take longer than 3 hours to charge the battery if the
temperature is near the minimum (0°C, 32°F) or maximum
(35°C, 95°F) charging temperature.

you reset the SF51 scanner control firmware. For more

§ Note: When you place the SF51 in the 1-bay or 4-bay charger,
information, see “Resetting the SF51” on page 31.

Checking the Battery Status

* Press the Scan button.

If the status light on the SF51 turns red, the battery is low

(less than 20% battery capacity remaining). You need to
charge the battery now.

SF51 Cordless Scanner User’s Guide 3
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How to Turn On the SF51

You use the Scan button to turn on the SF51.

To turn on the SF51
e Press the Scan button.

The first time you press the Scan button to turn on the SF51, it
enters a discoverable state so that your host Bluetooth device can
perform a device discovery and establish a Bluetooth connection.

If the status light on the SF51 turns red when you try to turn
on the scanner, you need to charge the battery. For help, see
“Charging the Battery” on page 3.

To turn off the SF51

* Scan this bar code:

Scanner Power Down

\60\08\2A\46

4 SF51 Cordless Scanner User’s Guide
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Understanding the Lights

The lights on the SF51 turn on to indicate the status of the
battery, a successful decode of a bar code, or the status of the
Bluetooth connection.

Intermec
Ready-to-Work
indicator

SF51 Lights: The status light turns green or red to indicate the
status of the battery and scanning. The blue Intermec Ready-to-
Work™ indicator turns on to let you know that the SF51is ready to
send data to your host Bluetooth device.

Understanding the Status Lights

Light State

What It Means

Blinks green one The SF51 successfully decoded a bar code and sent the

time

data to the host.

The SF51 successfully scanned a configuration bar
code.

Flashes red whenyou The battery is low. You need to place the SF51 in the 1-
press the Scan bay or 4-bay charger.

button

Flashes red and stays You scanned a bar code, but the data was not sent to
on for 2 seconds the host.

Off

Blinking

SF51 Cordless Scanner User’s Guide

You scanned a configuration bar code and the SF51
did not accept it.

A Bluetooth connection to the host computer is not

established.

The SF51 is trying to establish a Bluetooth connection
with the host computer, or the SF51 is moving out of
range of the host computer.
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Understanding the Status Lights (continued)

Light State
On

What It Means

A Bluetooth connection with the host computer has
been established. The SF51 is ready to scan bar codes
and send data to the host computer.

status light indicates the battery charging status. For more

§ Note: When the SF51 is in the 1-bay or 4-bay charger, the

information, see the instructions that ship with the charger.

Understanding the Beeps

The SF51 uses beeps to give you audio feedback when it performs
some functions. For example, you hear a beep each time you scan
avalid bar code.

Understanding the Beep Sequences

Beep Sequence

Single beep

Series of beeps from

low to high

Series of beeps from

high to low
Three beeps

Continuous beeping
for 1 minute

What It Means
The SF51 successfully decoded a bar code or scanned a
configuration bar code.

The SF51 connected to a Bluetooth host.
A Bluetooth connection has been lost.

Data was not successfully sent to the host. The SF51 is
out of range of the host.

A configuration bar code was not successfully scanned.
The host PC is paging the SF51. After you find the
SF51, press the Scan button to stop the beeps. For

more information about paging the SF51, see “Paging
the SF51” on page 30.

You can change the beep volume for your needs and
environment. You can set the beep volume to Low (quiet),

Medium (loud), and High (very loud - default).

SF51 Cordless Scanner User’s Guide
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Turning off the beeper does not affect the beeps associated with

§ Note: To turn off the beeper, you set the Beep Duration to 0.
Bluetooth Connect/Disconnect or Bluetooth Device Page.

You can also change the beeper duration and beeper frequency.
For more information about the beeper commands, see
Chapter 4, “Configuration Command Reference.”

Scanning Bar Codes

The SF51 has a linear imager you can use to scan and enter bar
code data. The linear imager can decode 1D and 2D stacked bar
codes. When you unpack the SF51, these bar code symbologies
are enabled:

* Code39

* Code 128/EAN 128

* PDF417 (only available on the SF51 with PDF version)
« UPC/EAN

If you are using bar code labels that are encoded in a different
symbology, you need to enable the symbology on the SF51. Use
EasySet version 5.4 or later to enable and disable symbologies for
your scanner. You can download it at no charge from the
Intermec web site at www.intermec.com/EasySet.

To scan a bar code label
1 Establish a Bluetooth connection between the SF51 and your
host device. For more information about establishing a
Bluetooth connection, see “Connecting the SF51 to a Host
Device” on page 12.
2 Point the SF51 at the bar code label and hold the SF51 ata
slight angle 15 to 25 cm (6 to 10 in) from the label.

3 Press the Scan button. The scanner beam turns on. Scan this
test bar code:

Code 39 Test Bar Code

*123456*

Tip: Depending on your screen resolution, you may be able
to scan bar codes displayed on your computer screen.

SF51 Cordless Scanner User’s Guide 7
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4 Ifyou are scanning a 1D bar code, direct the red scanner
beam so that it falls across all bars in the bar code label.

If you are scanning a 2D bar code, pass the beam over the bar
code label in a steady sweeping motion. The scanner emits a
crackle sound.

Vi

Scanning With the SF51: There are two different ways to
comfortably hold the SF51.

When the SF51 successfully reads a bar code label, you hear a
single beep and the status light briefly turns green. If Vibrate
Alert is enabled, the SF51 briefly vibrates.

5 Release the Scan button.

Using Vibrate Alert

You can configure the SF51 to vibrate when a bar code is
successfully decoded. This feature can be useful in these
situations:

* You are in a noisy environment, such as a busy warehouse,
where it can be difficult to hear the beep.

You are working in a quiet environment, such as a library,
where you do not want to make a lot of noise.

8 SF51 Cordless Scanner User’s Guide
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To turn on vibrate alert

¢ Scan this bar code:

Turn On Vibrate Alert

\60\03\10\48\00\02\40

To turn off vibrate alert

* Scan this bar code:

Turn Off Vibrate Alert

\60\03\10\48\00100\00

SF51 Cordless Scanner User’s Guide 9
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Connecting and
Configuring the SF51

Use this chapter to understand how to
configure the SF51 to communicate with your
application. This chapter covers these topics:

* Connecting the SF51 to a Host Device
* Configuring the SF51 Parameters

* Configuring Bluetooth
Communications

n
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Connecting the SF51 to a Host Device

12

You can use Bluetooth radio communications to connect the
SFS51 to these host devices:

* Intermec computer with a Bluetooth radio, such as the 700
Color Series (with Windows Mobile 2003 or later), CK30,
CK32, CN3, CK3, CK60, CV30, and CV60.

* PC with a USB Bluetooth adapter (P/N 203-771-xxx) or
RS-232 Bluetooth adapter (P/N 203-768-xxx).

*  Other devices with a Bluetooth radio that support a Serial
Port Profile (SPP). For help, see the documentation for your
device.

Before connecting the SF51 to a host device, note the Bluetooth
address for the:

*  host Bluetooth device.
e SFS1.

Bluetooth
address o

SF51Bluetooth Address: The SF51 Bluetooth address is located in
the upper right corner of the label on the back of the SF51.

SF51 Cordless Scanner User’s Guide
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Connecting to an Intermec Computer

Note: When you connect to an Intermec computer, all SF51

§ settings that are common to the Intermec computer’s internal
scanner settings are changed to the default settings of the
internal scanner.

To connect to an Intermec computer

1

£

Install EasySet version 5.4 or later on a host PC. EasySet is
available on the Intermec web site at www.intermec.com/
EasySet.

Start EasySet. Make sure that SF51 is selected as your
product.

From the EasySet commands window, select Data
transmission settings > Bluetooth parameters > connect/
disconnect.

Double-click compose BT address.

Enter the Bluetooth address of your Intermec computer and
click OK. The bar code appears on the setup sheet.

Scan the bar code onscreen with the SF51, or print the bar
code setup sheet and scan the bar code.

The SF51 beeps once, the green status light flashes once, and
the blue Intermec Ready-to-Work indicator starts blinking.
On your Intermec computer, the Authen. Request dialog box
appears.

In the Enter PIN field, enter the default PIN (0000) and
select OK.

When the SF51 connects to your Intermec computer, the
SF51 emits a series of beeps from low to high, and the blue
Intermec Ready-to-Work indicator turns on and stays on.
The SF51 is ready to scan data.

Note: To connect more than one SF51 to your Intermec
computer, use the Bluetooth Device Utility on the on the
Intermec computer. For help, see the documentation for your
Intermec computer.

SF51 Cordless Scanner User’s Guide 13
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Connecting to a Host PC With the Bluetooth
Adapter

To connect using a Bluetooth adapter

1

2

Install the USB Bluetooth adapter (P/N 203-771-xxx) or
RS-232 Bluetooth adapter (P/N 203-768-xxx) and software
on your host PC.

Connect and pair your SF51 with your host PC.

For help, see the instructions that ship with the adapter.

To disconnect from a host PC

Scan this bar code:

Bluetooth Device Disconnect

\60\02\52\05\00100106\00\00\00\00\00\00\00\00\00

The SF51 disconnects from your host PC, emits a series of
beeps from high to low, and the blue Intermec Ready-to-
Work indicator turns off.

Tip: Depending on your screen resolution, you may be able
to scan bar codes displayed on your computer screen.

Connecting as a Keyboard Wedge

You can connect your SF51 to your host PC as a keyboard wedge.
Connecting as a keyboard wedge lets your host PC receive data
from the SF51 as it would from a keyboard. You can use one of
these applications:

14

Keyport™ Bluetooth is a keyboard wedge application that
allows your host PC application to receive data directly from
the SF51. Keyport Bluetooth runs on Windows XP with SP2.

Keyport Lite is a keyboard wedge application that supports
English QWERTY keyboards. Keyport Lite runs on Windows
2000 and Windows XP with SP1.

This section describes how to connect using Keyport Bluetooth
and Keyport Lite. For more information about these
applications, see the documentation that ships with each
product.

SF51 Cordless Scanner User’s Guide
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Connecting Using Keyport Bluetooth

To connect using Keyport Bluetooth

1 Connect your SF51 to your host PC running Windows XP
with SP2 or later. For help, see the previous section,
“Connecting to a Host PC With the Bluetooth Adapter.”

2 Install Keyport Bluetooth on your PC.
3 Start Keyport Bluetooth.
4 Click the Registration tab.

= Keyport Bluetooth

About || Connections | Format | Trace | Registration

Serial Mumber:
MHame:

Compary Mame:

Mo Bluetooth radios found

[ 0k, H Cancel ” Apply ]

5 Fill in the registration information, and then click Apply.

SF51 Cordless Scanner User’s Guide 15
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6 Click the Connections tab.

= Keyport Bluetooth

&bout | Connections | Fommat | Trace | Registration

Discover

Reconnect
[J0n Start

[] Existing

Mo Bluetooth radios found

[ 1]4 H Catcel ]

7 Make sure that your SF51 is on and discoverable, and then
click Discover. Keyport Bluetooth searches for Bluetooth
devices.

8 From the list, select your SF51 and click Connect.

9 Keyport Bluetooth connects to your SF51 as a keyboard
wedge.

10 Click OK.

Connecting Using Keyport Lite
To connect using Keyport Lite

1 Connect your SF51 to your host PC. For help, see
“Connecting to a Host PC With the Bluetooth Adapter”
on page 14.

2 Install Keyport Lite on your PC.

16 SF51 Cordless Scanner User’s Guide
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3 Start Keyport Lite. From the Window menu, select Change
Registration. The Registration Form appears.

=10l

Serial number from product CO.

Serial Number: |

Your Name: |

Company Name: |

Street Address: |

City, State Zipcode: |

I Is this for installation on & Citrix System?

(i} | Cancel

4 Fill in the information on the Registration Form, and click
OK.

5 From the Window menu, select Options. The Options
window appears.

Program Contral

Port; | cam 4 j' Data Bits: lm
Baud: | 9600 'l Stop Bits: |1 ‘I
Paiity; | even 'I [~ EnsbleDTR

[~ EnsbleRTS
[~ Enable X0nA0fH

oK | Cancel |

6 In the Port field, select the COM port being used for
Bluetooth communications, and click OK.

§ Note: You can use either the incoming or outgoing COM port.

7 Click the Start button. Your SF51 is connected to your host
PC as a keyboard wedge.
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Collecting Data With Your SF51

After you connect your SF51 to your host device, you are ready to
start collecting data. The method you use depends on whether
you are using:

* an Intermec computer.
* ahostPC.
* the SF51 as a keyboard wedge.

To collect data with your SF51
1 Establish a Bluetooth connection.

2 Start your data collection application.

3 (Host PC only) Configure your data collection application to
receive data from the incoming or outgoing COM port.

4 Scan a bar code with your SF51. The data is entered into your
application.

For more information, see “Connecting the SF51 to a Host
Device” on page 12.

Configuring the SF51 Parameters

You can configure many parameters on the SF51, such as the bar
code symbologies it decodes or the volume of the beeper. These
characteristics are controlled by configuration commands. The
values you set for these configuration commands determine how
the scanner operates.

You can configure the SF51:
* using EasySet version 5.4 or later.

* remotely from your Intermec computer.

Configuring the SF51 With EasySet

18

EasySet is an Intermec configuration application that provides
you with two ways to configure the SF51:

* Send configuration commands directly to the SF51.

* Send configuration commands to a bar code setup sheet. You
can scan the bar codes onscreen with your SF51 or print the
setup sheet and scan the bar codes. You do not need a
Bluetooth connection to use this method.
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For more information about EasySet, see the EasySet software.
For descriptions of the configuration commands, see Chapter 4,
“Configuration Command Reference.”
To configure the SF51 by sending commands from EasySet

1 Establish a Bluetooth connection with your host PC.

2 Start EasySet version 5.4 or later. The first time you start
EasySet, the Select product dialog box appears.

If the Select product dialog box does not appear, choose
Product > Select.

3 Select the SF51.

4 Select the Online Setup check box, and click OK. The
Online Setup dialog box appears.

5 Select the COM port that your SF51 is using for Bluetooth
communications, and click OK.

EasySet connects to your SFS1 and retrieves the current
configuration of the SF51.

6 In the Commands window, choose configuration command
settings for your SF51.

Your SF51 is updated with the new configuration command
settings, and the settings are added to the bar code setup sheet.

§ Note: The SF51 does not beep when you send configuration

commands online from EasySet.

To configure the SF51 by scanning bar codes

1 Start EasySet version 5.4 or later. The first time you start
EasySet, the Select product dialog box appears.

If the Select product dialog box does not appear, choose
Product > Select.

2 Select the SF51, and click OK.

3 In the Commands window, choose configuration command
settings for your SF51 and add them to the bar code setup
sheet.

4 Scan the bar codes onscreen with your SF51, or print the
setup sheet and scan the commands. When you scan bar code
configuration commands, the SF51 emits a series of beeps
unless the volume is turned off:
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*  One beep means you scanned a valid configuration
command.

* Three beeps means you scanned an invalid configuration
command.

Configuring the SF51 From Your Intermec
Computer

%

You can configure many settings for the SF51 from your
Intermec computer. For descriptions of the configuration
commands, see Chapter 4, “Configuration Command
Reference.”

Note: When you connect to an Intermec computer, all SFS1
settings that are common to the Intermec computer’s internal
scanner settings are changed to the default settings of the
internal scanner.

To configure the SF51 from your Intermec computer

1 Establish a Bluetooth connection with your Intermec
computer. For help, see “Connecting to an Intermec
Computer” on page 13.

2 On your Intermec computer, start the Intermec Settings
application.

3 Select Data Collection > SF51 Scanner Bluetooth Address,
where Bluetooth Address is the Bluetooth address of your SF51.

4 Configure commands from the SF51 Scanner menu for your
SFS51.

5 Select File > Save Settings. The SF51 is updated with the
new configuration command settings.

6 Close Intermec Settings.

Restoring Default Settings

20

You can restore the SF51 to its default settings by scanning the
Administrator Reset Factory Defaults command. For a list of the
default settings, see “Configuration Commands By Function”
on page 35.
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Note: Using the Administrator Reset Factory Defaults
command resets all parameters. As a result, you will lose

Bluetooth communications.

To restore default settings

¢ Scan this bar code:

Administrator Reset Factory Defaults

\60\08\55\22

Configuring Bluetooth Communications

The SFS1 can communicate with a host device through the Serial
Port Profile (SPP) Bluetooth communications profile.

SPP allows the SF51 to use the Bluetooth link as a serial port to
communicate with the host device. You can send information
from the SF51 to your serial application without having to
modify your application.

You can initiate a Bluetooth connection from either your SF51 or
host device:

* Ifyou initiate the connection from your SF51, you can only
connect one SF51 to your host device. When you reset the
SF51 by placing it in a charger, the SF51 automatically
reestablishes the Bluetooth connection.

* Ifyouinitiate the connection from a host device, you can
connect more than one SF51 to the same host device. When
you reset the SF51 by placing it in a charger, you need to
reestablish the Bluetooth connection from your host device.

Configuring Security

The SF51 provides Bluetooth wireless security for transmitting
data. By default, security is active on your SF51. For maximum
security, you need to configure a Bluetooth PIN (personal
identification number).

This section assumes that you have already installed EasySet
version 5.4 or later.
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To configure a Bluetooth PIN for your SF51

1 Start EasySet version 5.4 or later.
2 Select the SF51, and click OK.

3 In the Commands window, select Data transmission
settings > Bluetooth parameters > security.

4 Select active.

5 Select compose PIN and create a Bluetooth PIN that is up to
16 characters in length. The default Bluetooth PIN is 0000.

6 Scan both commands onscreen with your SF51, or print the
bar code setup sheet and scan both commands.

Note: For security reasons, you can only change the Bluetooth
PIN by scanning a bar code.

Configuring the Discoverable State of the SF51

By default, the SFS1 is always discoverable. For enhanced
security, you should configure your SF51 for limited
discoverability, which allows the SF51 to be discoverable by
Bluetooth management applications for only 30 seconds. For
more information, see “Bluetooth Discoverable” on page 39.

To configure your SF51 for limited discoverability
e Scan this bar code:

Bluetooth parameters - discoverable - limited

\60\02\50\41\00\02\40

The SF51 is discoverable for 30 seconds.
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Troubleshooting and
Maintaining the SF51

Use this chapter to solve problems you may
have while using the SFS1. This chapter
contains these topics:

Troubleshooting the SF51
Upgrading the SF51
Paging the SF51

Resetting the SF51
Cleaning the SF51
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Troubleshooting the SF51

Use this chapter to troubleshoot some common problems you
may experience with your SF51. If you cannot find the answer to
your problem in the “Problems and Solutions” section on page
29, you may need to call Product Support.

Calling Product Support
To talk to an Intermec Product Support representative, call:
1-800-755-5505

Before you call Intermec Product Support, make sure you have
the following information ready:

* Product version
*  Sub-system versions
*  Bluetooth address of your SF51

To get the product version, sub-system versions, or Bluetooth
address

1 If necessary, install the USB Bluetooth adapter
(P/N 203-771-xxx) or RS-232 Bluetooth adapter
(P/N 203-768-xxx) and create a Bluetooth connection
between your SF51 and your PC. For help, see the
instructions that ship with the adapter.

2 Run an application that can accept bar code information
from the SF51, such as HyperTerminal.

3 Scan these bar codes:

Get Product Version

\60\0F\37\20

Get Sub-System Versions

\60\OF\37\24
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Get SF51Bluetooth Device Address

\60\0F\37\23

Tip: Depending on your screen resolution, you may be able
to scan bar codes displayed on your computer screen.

Problems and Possible Solutions

Use this section to find problems and possible solutions.
Troubleshooting the SF51

Problem Possible Solution

Your SF51 hasbeen  If your SF51 is within Bluetooth communication

misplaced, and you  range of your host PC, you can send the Bluetooth

cannot find it. Device Page command from EasySet to locate your
SF51. For help, see “Paging the SF51” on page 30.

You place the SF51 ~ When you place the SF51 in a 1-bay or 4-bay charger,

in a charger and you reset the SF51, and the scanner control firmware
lose Bluetooth restarts. If you have a Bluetooth connection, the SF51
communications. disconnects from the host device while the firmware
resets. For more information, see “Resetting the
SF51” on page 31.
You cannot establish Scan the following bar code to reset the scanner to its
a Bluetooth default configuration and try establishing a
connection (the blue connection again. Using the Administrator Reset
Intermec Ready-to-  Factory Defaults command resets all settings. As a
Work indicator is not result, you will lose Bluetooth communications.
on). Administrator Reset Factory Defaults
\60\08\55\22
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Troubleshooting the SF51 (continued)

Problem

You are trying to
establish a Bluetooth
connection from a
host device to your
SFS51, but the host
device cannot find
your SFS1.

When you press the
Scan button, the red
scanner beam does
not turn on.

You changed the
Bluetooth PIN from
its default value of
0000, but you forgot
your new PIN
number.

You established a
Bluetooth
connection with an
Intermec computer,
and the settings on
your SF51 were
restored to their
default values.

26

Possible Solution

The SFS51 may not be in a discoverable state. For help,
see “Bluetooth Discoverable” on page 39.

The SF51 may be connected and paired to another
Bluetooth device. Scan the following bar code to reset
the SF51 to its default settings and disconnect
Bluetooth communications. Try establishing a
connection again.

Using the Administrator Reset Factory Defaults
command resets all settings. As a result, you will lose
Bluetooth communications.

Administrator Reset Factory Defaults

\60\08\55\22

The battery is low. Charge the battery immediately
and try scanning again.

Scan this bar code to reset the scanner to its default
configuration and default Bluetooth PIN of 0000.

Administrator Reset Factory Defaults

\60\08\55\22

When you connect to an Intermec computer, all SF51
settings that are common to the Intermec computer’s
internal scanner settings are changed to the default
settings of the internal scanner. Scan configuration
bar codes, or use Intermec Settings on your Intermec
computer to change your SF51 settings.
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Troubleshooting the SF51 (continued)

Problem Possible Solution

You press the Scan  The data may still be in the process of being sent to
button to scan a data the host. Data transmission may be slow if there is

bar code, the SF51 interference with Bluetooth communications, or if the

does not beep, and ~ SF51 is too far from the host device. If you are using

the scanner beam Level Trigger Mode, the scanner beam blinks while the

starts blinking. SF51 is waiting. For more information, see “Trigger
Mode” on page 49.

You scan a bar code, The SF51 may not be connected to a host. Make sure

the Status light the blue Intermec Ready-to-Work indicator is on and
flashes red for two the SF51 is connected to your host device. For help,
seconds, and the see “Connecting the SF51 to a Host Device” on
scanner beeps three  page 12.

times.

You are using the Try these possible solutions:

SF51 in keyboard * Make sure that your data collection application is
wedge mode, and open

when you try to scan
a bar code, and

nothing happens.

and running.

* Make sure that you pressed the Keyport Lite Start
button.

For help, see “Connecting as a Keyboard Wedge” on
page 14.

Upgrading the SF51

When you upgrade your SF51, you update the SF51 processor
firmware. The current settings are erased and replaced with the
default settings for the SF51. You need to reestablish Bluetooth
communications between your SF51 and other Bluetooth devices
and applications in your data collection system.

To upgrade the SF51, you need these items:

» SF51 firmware upgrade package:
* SFS51Upgrade.exe (SFS1 Firmware Upgrade Utility)
*  SF51_xx_xx.ldr (firmware upgrade file)
* readme.txt (upgrade instructions)

* USB Bluetooth adapter (P/N 203-771-xxx) or RS-232
Bluetooth adapter (P/N 203-768-xxx)
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*  PC running Microsoft Windows 2000/XP with SP1 or SP2

Before upgrading the SF51, you should fully charge the SF51
battery. For help, see “Charging the Battery” on page 3.

To upgrade the SF51
1 Download the latest upgrade package from the Intermec web

site at www.intermec.com.

a Go to Support > Downloads > Search Product and
Software Downloads.

b From the Select A Product drop-down list, choose Bar
Code Scanners: SF51 Cordless Scanner.

¢ Click the link to download the upgrade package, and save
it to your PC.

Remove the SF51 from the charger.

If necessary, install the USB or RS-232 Bluetooth adapter and
create a Bluetooth connection between your SF51 and your
PC. For help, see the instructions that ship with the adapter.

Note: Make sure that all applications on your PC are closed.

Start the SF51 Firmware Upgrade Utility.

Scan the bar code to reset to factory defaults and click Next.
See “To restore default settings” on page 21 for the reset
factory defaults bar code.

Click Browse to browse to the location of the firmware (.1dr)
file.

Select the firmware file and click Open.

Enter the Bluetooth Address of the SF51 to be upgraded and
click Next.

The Status Bar appears and the upgrade utility loads the
latest firmware on your SF51.

Note: Do not place the SF51 in the 1-bay or 4-bay charger
during the firmware upgrade, because the SF51 may lock up.

The upgrade utility notifies you when the upgrade is complete.
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Troubleshooting the Firmware Upgrade

If the SF51 locks up during the upgrade procedure and does not
respond when you press the Scan button or place it in a charger,
you may still be able to connect to it from your PC and upgrade
the firmware.

To troubleshoot a locked up SF51

1 Make sure that the SF51 is not seated in the 1-bay or 4-bay
charger.

2 From your PC, use the Bluetooth application to search for
Bluetooth devices.

3 Ifyour SF51 appears in the list, connect to it from the
Bluetooth application.

If your SE51 does not appear in the list, contact Intermec
Support Services at 1-800-755-5505.

4 When the Bluetooth PIN Code Request box appears, enter
the following case-sensitive PIN in the Bluetooth PIN Code
field, and click OK:

zxcvasdfqwer

The Bluetooth application connects to the boot loader code
on your SF51. “Intermec SF51 Boot Server” may appear in
the Device Name list instead of the name of your SF51
scannetr.

5 Use your Bluetooth application to connect to the Intermec
SF51 Boot Server.

6 Start the SF51 Firmware Upgrade Utility.

7 Click Browse to browse to the location of the firmware (.1dr)
file. Select the firmware file and click Open.

8 From the COM Port drop-down list box, select the COM
port that the Intermec SF51 Boot Server is using for
Bluetooth communications.

9 Click Next. The Bluetooth address of your SE51 appears, the
status bar appears, and the upgrade utility upgrades your
SF51 with the latest firmware.

name may be “Intermec SF51 Boot Server.” When the Bluetooth
PIN Code Request box appears, enter the default PIN, which is
0000. After you connect, the name and Bluetooth address of
your SFS51 should appear in your Bluetooth application.

§ Note: The next time you connect to your PC, your SFS51 device
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Paging the SF51

30

%

If your SFS1 is within Bluetooth communication range of your
host PC, you can send the Bluetooth Device Page command from
EasySet to locate the SF51.

Note: If the SF51 is turned off, your host PC cannot connect to
it and send the Bluetooth Device Page command.

To page the SF51

1 Start EasySet version 5.4 or later. Make sure that SF51 is
selected as your product.

2 Select Communication > Connect.
3 Select the appropriate COM port, and click OK.

4 Select the Send to product check box below the commands
window.

5 In the EasySet Commands window, select Configuration
modes and utilities > Bluetooth device page.

The SF51 beeps continuously for 1 minute or until you find
the SFS1 and press the Scan button.
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Resetting the SF51

If the SF51 appears to be locked up, you can reset it. When you
reset the SF51, the scanner control firmware is restarted.

To reset the SF51
* Place the SF51 in the 1-bay or 4-bay charger.

If you have a Bluetooth connection, the SF51 disconnects from
the host device.

When you reset the SF51:

e The SF51 tries to reestablish a Bluetooth connection with the
host device if the SF51 initiated the Bluetooth connection.

e The SF51 turns on and enters a discoverable state if the host
device initiated the Bluetooth connection. You need to
reestablish the Bluetooth connection from the host device.

Cleaning the SF51

To keep the SF51 in good working order, you may need to clean
the scanner window. Clean the scanner window as often as
needed for the environment in which you are using the SF51. To
clean the scanner window, you can use soapy water, a solution of
ammonia and water, or isopropyl alcohol.

2 Opening the SF51 will void the warranty and may cause

damage to the internal components.

Caution

To clean the scanner window

1 Dip a clean towel or rag in soapy water, ammonia and water
solution, or isopropyl alcohol and wring out the excess. Wipe
the scanner window. Do not allow any abrasive material to
touch the window.

2 Wipe dry with a lint-free cloth.
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Configuration
Command Reference

Use this chapter to learn about the commands
supported on the SF51. This chapter contains
these topics:

* Using Configuration Commands
* Configuration Commands By Function

* SF51 Configuration Commands
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Using Configuration Commands

34

A configuration command changes the way the SF51 operates.
For example, you can change the Beep Volume and make the
SF51 beeper very quiet for a quiet environment.

You can configure the SF51:

by sending commands to your SF51 from your PC using
EasySet. For help, see “To configure the SF51 by sending
commands from EasySet” on page 19.

by sending commands to a bar code setup sheet. Then, scan
the bar codes onscreen with your SF51, or print the setup
sheet and scan the bar codes. You do not need a Bluetooth
connection to use this method. For help, see “To configure
the SF51 by scanning bar codes” on page 19.

from your Intermec computer. Send commands to your SF51
from your Intermec computer using Intermec Settings. For
help, see the procedure “To configure the SF51 from your
Intermec computer” on page 20.

For a list of all the commands and their default values as they are
organized in EasySet, see the next section, “Configuration
Commands By Function.”

For descriptions of each command organized alphabetically, see
“SF51 Configuration Commands” on page 38.
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Configuration Commands By Function

The configuration commands are grouped by function and
reflect the organization of the Commands window in EasySet.

Command

Administrator reset
factory defaults

User reset factory
defaults

Bluetooth Command

Bluetooth security
Bluetooth PIN

Bluetooth discoverable

Bluetooth profile
Bluetooth device name

Bluetooth connect/
disconnect

Data Transmission
Command

Data editing
Postamble
Preamble

Symbology identifier

SF51 Cordless Scanner User’s Guide

Default Value
N/A

N/A

Default Value
Active

0000

Fully discoverable

Serial port profile
(SPP)

SF51 Scanner
<Bluetooth Address>

Disconnect

Default Value
N/A
<CR><LF>
None

Not transmitted

See Page
38

51

See Page
40

40

7

40

39

See Page
43
46
46
47
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Symbology Default Value See Page
Disable all symbologies N/A 43
Codabar Not active 41
Codablock
Codablock A Not active 41
Codablock F Not active 41
Code 11 Not active 41
Code 39 Active 41
Code 93/93i1 Not active 41
Code 128/EAN 128 Active 42
ISBT 128 Active 42
GTIN processing Not active 42
EAN.UCC Composite  Not active 44
Interleaved 2 of 5 Not active 45
Matrix 2 of 5 Not active 45
Micro PDF417 Not active 45
MSI Not active 45
PDF417 Active 45
Plessey Not active 46
RSS
RSS 14 Not active 46
RSS Expanded Not active 46
RSS Limited Not active 47
Standard 2 of 5 Not active 15
Telepen Not active 48
TLC 39 Not active 17
UPC/EAN Active 51
ISBN Not active 51
GTIN processing Not active 51

available on the PDF version of the SF51. For help
setting symbology options, see the EasySet software.

§ Note: Stacked 2D bar code symbologies are only
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Trigger Activation
Command

Trigger mode

Trigger timeout

Default Value

Level

2 sec

Turn off after good read Active

Data Decoding
Security Command

Consecutive same read
data validation

Timeout between
identical consecutive
codes

Timeout between
different consecutive
codes

Beeps/Green Indicator
LED Command

Beep volume
Note (Beep frequency)
Good read beeps
Number
Duration
Timing
Good read LED
duration
Error beep
Setup beep
2D symbologies
Stacked code crackle
Vibrate alert
Vibrate alert

Duration

SF51 Cordless Scanner User’s Guide

Default Value

Auto read count before
transmission

300 ms

None

Default Value
High
2610 Hz

1

80 ms

After transmission
2000 ms

On
On

On

Off
300 ms

See Page

49
50
50

See Page
43

48

48

See Page

39
38

44
44
44
12

44
15

47

20
52
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Command Default Value See Page
Configuration modes  Configuration 43

and utilities Enabled

Bluetooth device page N/A 39

SF51 Configuration Commands

This section lists the configuration commands in alphabetical
order and provides a description of each command. To configure
your SF51 using these commands, see the EasySet software.

Administrator Reset Factory Defaults

Causes the SF51 to perform a restart and restores all
configuration commands to their default settings. When you
restore all configuration commands to their default settings, you
need to reestablish Bluetooth communications.

Beep Duration

Sets the length of the beeps. You can set Beep Duration to a value
from 0 to 2550 ms. When Beep Duration is set to 0 ms, the
beeper is off. Turning off the beeper does not affect the beeps
associated with Bluetooth Connect/Disconnect or Bluetooth
Device Page.

Use Beep Duration in combination with Beep Frequency and
Beep Volume to define beeps according to operator preference
and work environment.

Beep Frequency

Sets the frequency, or pitch, of the beeps. You can set Beep
Frequency to a value from 1000 to 5110 Hz.

Use Beep Frequency in combination with Beep Volume and
Good Read Beep Duration to define beeps according to operator
preference and work environment.
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Beep Volume

Adjusts the volume of the beeps. You can set Beep Volume to
Low, Medium, or High.

Turning off the beeper does not affect the beeps associated with

§ Note: To turn off the beeper, you set the Beep Duration to 0.
Bluetooth Connect/Disconnect or Bluetooth Device Page.

Use Beep Volume in combination with Beep Frequency and
Good Read Beep Duration to define beeps according to operator
preference and work environment.

Bluetooth Connect/Disconnect

Connects or disconnects Bluetooth communications between
the SF51 and host computer if you are using Serial Port Profile
(SPP).

To connect to a host computer, enter the Bluetooth address of
the computer and scan the bar code with the SF51. To
disconnect, scan the disconnect bar code.

Bluetooth Device Name

Sets the name of the scanner. If the scanner is in a discoverable
state, its Bluetooth device name is available to host computers
during device discovery.

Bluetooth Device Page

If your SFS1 is within Bluetooth communication range of your
host PC, you can send this command from EasySet to locate the
SFS51. For help, see “Paging the SF51” on page 30.

Bluetooth Discoverable

Determines the discoverable state of the SF51. When the SF51 is
discoverable, it is visible to other Bluetooth devices in
communication range.
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State Description

Fully The SF51 is discoverable to Bluetooth management
applications.

Limited The SF51 is discoverable to Bluetooth management
applications for 30 seconds.

Not The SF51 is not discoverable to Bluetooth management
applications.

host device.

§ Note: The SF51 is not discoverable when it is connected to a

Bluetooth PIN

When Bluetooth security is enabled, the Bluetooth PIN is

used to authenticate the Bluetooth link and encrypt the data.
Depending on the Bluetooth software on your host device, you
should only need to enter the Bluetooth PIN the first time you
connect and pair the SF51.

For help configuring a Bluetooth PIN; see “Configuring
Security” on page 21.

Bluetooth Profile

Configures the SF51 to connect to a host device through

the Serial Port Profile (SPP) Bluetooth communications profile.
SPP allows the SF51 to use the Bluetooth link as a serial port to
communicate with the host device.

For more information, see “Configuring Bluetooth
Communications” on page 21.

Bluetooth Security

Enables or disables Bluetooth security. When Bluetooth
security is enabled, you need to enter the SF51 Bluetooth PIN
before you can use the scanner. For more information, see
“Configuring Security” on page 21.
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Codabar

Enables or disables decoding of Codabar symbology. Codabar
is a self-checking, discrete symbology. The American Blood
Commission (ABC) Codabar requires that you retain and
transmit the start/stop code digits when processing a Codabar
symbol. As a result, configuration CD10 is an illegal
configuration.

Codablock A

Enables or disables decoding of Codablock A symbology.
Codablock A is a 2D bar code that is an extension of Code 39. If
Code 39 is enabled with check digit, you cannot enable
Codablock A. For best results, disable Code 39 before you enable
Codablock A. If Code 39 is enabled with check digit, Codablock
A will not be decoded properly.

Codablock F

Code 11

Code 39

Enables or disables decoding of Codablock F symbology.
Codablock Fis a 2D bar code that is an extension of Code 128. If
Code 128 is enabled with check digit, you cannot enable
Codablock F. For best results, disable Code 128 before you
enable Codablock F.

Enables or disables decoding of Code 11 symbology. Code 11isa
very high-density, discrete numeric bar code. It is most
extensively used in labeling telecommunications components
and equipment.

Enables or disables decoding of Code 39 symbology. Code 39 is
discrete, variable length, and self-checking. The character set is
uppercase A to Z, 0 to 9, dollar sign ($), period (.), slash (/),
percent (%), space (), plus (+), and minus (-).

Code 93/93i

Enables or disables decoding of Code 93/93i symbology. Code
93/931 is a variable length, continuous symbology that uses four
element widths.

SF51 Cordless Scanner User’s Guide 41



Chapter 4 — Configuration Command Reference

Code 128/EAN 128

Enables or disables decoding of Code 128/EAN 128 symbology.
Code 128 is a very high-density alphanumeric symbology that
supports the extended ASCII character set. It is a variable length,
continuous code that uses multiple element widths.

Code 128 supports the following function codes.

Function Code  Description

FNC1

FNC2

42

FNC1 is used as a separator when multiple identifiers and
their fields are concatenated. For example, FNC1 can be
useful in keyboard wedge mode when the GS character
cannot be transmitted.

When the FNC2 character occurs in a bar code, the SF51
temporarily stores the data from the bar code and
transmits it as a prefix to the next symbol. In this way,
FNC2 can be used to concatenate several symbols before
the data is transmitted.

ISBT 128
Enables and configures decoding of ISBT Code 128 symbology.

ISBT Code 128 is the global bar code labeling standard for the
blood banking industry. It is used to support the worldwide
distribution, tracking, and handling of blood bags and blood

components.

GTIN Processing for EAN 128
With GTIN processing enabled, a GTIN compliant EAN 128
label will have the first two digits stripped and output 14 digits.

A GTIN (Global Trade Item Number) compliant EAN 128 label:
* is 16 digits long.

* has “01” as the first two digits of the label.
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Configuration Modes and Utilities

Use Configuration Modes and Utilities to:

» allow the SF51 to always accept configuration commands by
scanning bar codes or to timeout 1 minute after the last
configuration command is set by scanning a bar code.

* get the product version, sub-system versions, and Bluetooth
address of your SF51.

» page the SF51 from your host PC or turn off the SFS1.

For more information and bar codes, see “Calling Product
Support” on page 24.

Consecutive Same Read Data Validation

To increase decode security, you can have the scanner scan a bar
code multiple times to ensure you have a valid read before
transmitting the data.

You can set Consecutive Same Read Data Validation from 0 to
10. The default value of 0 sets the scanner to automatically adapt
the consecutive same read based on the bar code quality and the
trust level of the bar code. For example, labels with a check digit
require less reads than labels without a check digit.

Data Editing

Data editing allows you to edit data scanned by the SF51 before
it is transmitted to your host. You can define up to seven input
scenarios to filter out the data you want to edit. For more
information, see the EasySet software.

Disable All Symbologies

This command disables all symbologies. Disabling all
symbologies does not reset symbology parameters to their
default values. To reset all symbology parameters to their default
factory settings, use the Administrator Reset Factory Defaults
command. For more information, see “Administrator Reset
Factory Defaults” on page 38.

SF51 Cordless Scanner User’s Guide 43



Chapter 4 — Configuration Command Reference

EAN.UCC Composite

Enables or disables EAN.UCC Composite symbology. An
EAN.UCC Composite symbol consists of a linear component
(encoding the item's primary identification) associated with an
adjacent 2D Composite Component (encoding supplementary
data, such as a batch number or expiration date). The Composite
symbol always includes a linear component so that the primary
identification is readable by all scanning technologies, and so
that 2D imagers can use the linear component as a finder pattern
for the adjacent 2D Composite Component.

Error Beep

Enables or disables the error beep. When you scan a
configuration bar code that is damaged or unknown, you hear an
error beep, and the configuration of the SF51 is not changed.

Good Read Beep Duration

Sets the length of the SF51 good read beeps. You can set Good
Read Beep Duration to a value from 0 (off) to 2550 ms.

Use Good Read Beep Duration in combination with Beep
Volume and Beep Frequency to define beeps according to
operator preference and work environment.

Good Read Beep Number

Determines the number of beeps used for the good read beep: 1,
2, or none.

Good Read Beep Timing

Determines if the good read beep happens before or after
successfully transmitting data.

Good Read LED Duration

Sets the amount of time the green Status light stays on after a
good read. You can set Good Read LED Duration to a value from
0 (off) to 5110 ms. When the Status light is on due to a long
duration time, the SFS51 can still read new bar codes and receive
commands.
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Interleaved 2 of 5

Enables or disables decoding of Interleaved 2 of 5 symbology.
Interleaved 2 of 5 is a high-density, self-checking, continuous
numeric symbology. It is mainly used in inventory distribution
and the automobile industry.

Matrix 2 of 5

Enables or disables decoding of Matrix 2 of 5 symbology. Matrix
2 of 5 is a discrete bar code derived from Code 11.

ChinaPost is available as part of the Matrix 2 of 5 symbology
start/stop code. ChinaPost encodes 11 digits with no check digit
and has unique start and stop patterns.

Micro PDF417

Enables or disables decoding of Micro PDF417 symbology.
Micro PDF417 is a multi-row symbology based on PDF417. It is
designed to maximize area efficiency for applications that do not
need the maximum data capacity of PDF417. Micro PDF417
contains a limited set of symbol sizes that each includes a fixed
level of error correction.

MSI

Enables or disables decoding of MSI symbology. MSI code is
similar to Plessey code in that it includes a start pattern, data
characters, one or two check digits, and a stop pattern.

PDF417

PDF417 is only supported on the SF51 with PDF version.

Enables or disables decoding of PDF417 symbology. The
PDF417 symbology is a stacked 2D symbology that allows you to
scan across rows of code. Each row consists of start/stop
characters, row identifiers, and symbol characters, which consist
of four bars and four spaces each and contain the actual data.
This symbology uses error correction symbol characters
appended at the end to recover loss of data.
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Plessey

Macro PDF417, a feature of PDF417, extends the capability of
PDF417 by allowing up to 99,999 PDF417 symbols to be used to
store data. The symbols are concatenated as they are scanned and
can be scanned in any order.

Enables or disables decoding of Plessey symbology. Plessey code
is pulse-width modulated like most other bar codes. It includes a
start character, data characters, an eight-bit cyclic check digit, a
termination bar, and usually a reverse start character. The code is
continuous and not self-checking. You need to configure two
parameters for Plessey code: Start Code and Check Digit.

Postamble

Sets the postamble that is appended to any data you scan.
Common postambles include cursor controls such as a tab

or a carriage return line feed. You can set Postamble to up to 20
ASCII characters.

Preamble

RSS 14

%

Sets the preamble that precedes any data you scan. Common
preambles include a data location number or an operator
number. You can set Preamble to up to 20 ASCII characters.

Enables or disables decoding of RSS 14 (Reduced Space
Symbology 14) 1D or stacked 2D codes. RSS 14 is a numeric
symbology that can read stacked omni-directional bar code
labels. It is a member of the EAN.UCC RSS symbology family.

Note: To read RSS 14 stacked 2D codes, RSS Expanded or RSS
Limited must also be enabled.

RSS Expanded

46

Enables or disables decoding of RSS Expanded (Reduced Space
Symbology Expanded). RSS Expanded is an alphanumeric
symbology that can read RSS limited and stacked bar code labels.
It is a member of the EAN.UCC RSS symbology family.
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RSS Limited

Enables or disables decoding of RSS Limited (Reduced Space
Symbology Limited). RSS Limited is a numeric symbology that
does not read stacked bar code labels. It is a member of the
EAN.UCC RSS symbology family.

Setup Beep

Enables or disables the setup beep. When you successfully scan a
configuration bar code, you hear the setup beep, and the
configuration of the SF51 is changed.

Stacked Code Crackle

Enables or disables the crackle sound when you scan a stacked
(2D) bar code.

Standard 2 of 5

Enables or disables decoding of Standard 2 of 5 symbology.
Standard 2 of 5 is a low-density numeric symbology. It encodes
all information in the bars and uses the fixed-width spaces to
separate the bars. Standard 2 of S is used in warehouse sorting,
photofinishing, and airline tickets.

Symbology Identifier

Symbology identifiers allow you to indicate what type of data is
being sent by prepending an identifier to the data. You can
prepend one of the following types of character strings to
identify which symbology the data is using.
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Character String Description

AIM ISO/IEC The AIM Standard for symbology identifiers consists of a

standard

three-character structure indicating the symbology and
the optional features of the symbology. For more
information about the AIM Standard for symbology
identifiers, refer to the AIM ISO/IEC Standard.

User-defined The user-defined symbology identifier (UDSI) is one to
ASCII character  four ASCII characters in length. You can configure user-

string

Code Mark

Telepen

defined symbology identifiers to assign custom identifier
strings to the bar code symbologies.
The code mark identifier is a single character user-defined

symbology identifier. Its value can range from 0x00 to
OxFF.

Enables or disables decoding of Telepen symbology. Telepen is
the only symbology to directly represent the full ASCII character
set without shift characters. It is extremely secure as it has
negligible risk of misreads and has a double density numeric only
mode.

Timeout Between Different Consecutive Codes

Use this command to invalidate a second bar code read that
occurs before the timeout expires. Use this command when
scanning bar codes that contain different data as opposed to the
Timeout Between Identical Consecutive Codes command that
you use when your bar codes contain identical data.

You can set Timeout Between Different Consecutive Codes to a
value from 0 to 2550 ms.

Timeout Between Identical Consecutive Codes
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Use this command to invalidate a second bar code read that
occurs before the timeout expires. Use this command when
scanning bar codes with identical data as opposed to the
Timeout Between Different Consecutive Codes command that
you use when your bar codes contain different data.

You can set Timeout Between Identical Consecutive Codes to a
value from 0 to 2550 ms.
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TLC 39 is a “composite” symbology designed for the
Telecommunications Industry. TLC 39 combines a Code 39
symbol, encoding a part number (for items such as plug-in
boards at central switching stations) with a “linked”
MicroPDF417 symbol encoding a serial number and other
optional information.

The first 6 characters must be numeric and include the ECI
number. The 7th character is a delimiter between the linear data
portion and the composite data portion, typically a comma, but
other delimiters are allowed. The next piece of data is a
mandatory unique Serial Number.

There can be other data fields after the Serial Number, usually
either AppIDs or DatalDs, which are governed by whether or not
there are alpha characters in the serial number. Country Of
Origin is another typical data field that is included in this
symbology.

Trigger Mode

Trigger mode allows you to set different types of triggering for
the scanner.

Mode Description

Continuous/ When you press the Scan button, the red scanner beam

Edge turns and stays on. When you press the Scan button a
second time, the scanner turns off. Simply releasing the
button does not turn off the scanner.

Level When you press the Scan button, the red scanner beam

turns on and stays on until you release the Scan button or
until the SF51 successfully decodes a bar code.

When you scan a data bar code, data transmission may be
slow if there is interference with Bluetooth
communications, or if the SF51 is too far from the host
device. While the SF51 is waiting, the scanner beam blinks.
During this time, you can scan configuration bar codes but
not data bar codes. When the SF51 receives
acknowledgement from the host, the scanner turns off,
and the SF51 beeps.
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Mode Description

Pulse When you press the Scan button, the red scanner beam
turns on. The scanner remains on until the Trigger
Timeout period is reached.

Flashing When you press the Scan button, the red scanner beam
turns on and the SFS1 checks for a bar code to read. When
the Trigger Timeout period is reached, the scanner starts
flashing. When the SF51 finds and reads a bar code, it
resets the Trigger Timeout period. If you press the Scan
button a second time, the scanner turns off.

Autostand Autostand mode allows you to switch between level mode
and flashing mode. The first time you press the Scan
button, the scanner beam turns on and the scanner is in
flashing mode. You switch to level mode by pressing the
Scan button again. If the scanner is idle and the Trigger
Timeout period is reached, the scanner returns to flashing
mode.

Aim Aim triggering allows you to turn on the scanner and aim
the red scanner beam without causing a decode. Releasing
the Scan button enables the decode.

Note: EasySet contains a folder, Predefined Modes, in
Operating Settings > Trigger Activation. The commands in
this folder are currently not supported on the SF51.

Trigger Timeout

Set the Trigger Timeout for the Trigger Mode command. You can
set Trigger Timeout from 1 to 4095 seconds.

Turn Off After Good Read

Sets how the SF51 operates in level and pulse trigger modes.

Turn Off After
Trigger Mode  Good Read SF51 Behavior

Level Enabled The SF51 turns off after it successfully
reads a bar code.

Level Disabled The SF51 stays on until you release the
Scan button.
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Turn Off After
Trigger Mode  Good Read SF51 Behavior
Pulse Enabled The SF51 turns off after it successfully

reads a bar code.

Pulse Disabled The SF51 stays on until the Trigger
Timeout period is reached.

UPC/EAN

Enables or disables decoding of Universal Product Code (UPC)/
European Article Numbering (EAN) symbology. UPC/EAN are
fixed-length, numeric, continuous symbologies that use four
element widths. A scanner that is configured to decode EAN bar
codes can decode UPC, but the reverse is not true. UPC code is a
subset of EAN code.

ISBN

ISBN (International Standard Book Number) is a 10-digit
symbology that uniquely identifies books for tracking and
ordering.

With ISBN enabled, the first three characters (978) are ignored,
and the checksum is calculated on the remaining characters.

GTIN Processing

With GTIN (Global Trade Item Number) processing enabled,
two zeros are padded to the beginning of UPC-A, and one zero is
padded to the beginning of EAN-13 to expand the numbers to 14
digits. To use GTIN processing you also need to enable the
corresponding UPC/EAN symbology.

User Reset Factory Defaults

Causes the SF51 to perform a restart and restores all
configuration commands to their default settings, only if no
settings are locked. To reset all settings on the SF51, including
locked settings, use the Administrator Reset Factory Defaults
command. For more information, see “Administrator Reset
Factory Defaults” on page 38.

When you restore all configuration commands to their default
settings, you need to reestablish Bluetooth communications.
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Vibrate Alert

Enables or disables the vibrate alert. When Vibrate Alert is
enabled, the scanner vibrates when you scan a valid bar code.

Vibrate Alert Duration

Sets the amount of time that the vibrate alert remains on. You
can set Vibrate Alert Duration to a value from 0 to 2550 ms.
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Specifications
Use this section to find technical information about the SF51.

Physical Dimensions

Length: 15.7 cm (6.1 in)

Height: 3.4 cm (1.3 1n)

Width: 4.6 cm (1.8 in) at the scanner, tapered
to 3.2 cm (1.26 in) at the handle

Weight: 263 g(9.3 oz)

Power and Electrical Specifications

Operating: Rechargeable lithium-ion battery

Electrical rating: ==5V; 1.5A

Temperature and Environmental Specifications

Operating: -20°C to 50°C (-4°F to 122°F)

Storage: -20°C to 60°C (-4°F to 140°F)

Charging: 0°Cto35°C (32°F to 95°F)

Relative humidity: 0 to 95% non-condensing

Environmental rating: ~ IP52
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Bar Code Symbologies

e Codabar e MSI

¢ Codablock A e PDF417

e Codablock F * Plessey

e Codell ¢ RSS 14

e Code 39 ¢ RSS 14 Stacked
e Code 93/93i e RSS Limited

* Code 128 / EAN 128 * RSS Expanded
* EAN.UCC Composite ¢ Standard2of35

e Interleaved 2 of 5 * Telepen
¢ Matrix 2 of § e TLC 39
e Micro PDF417 e UPC/EAN

Note: PDF417 and Micro PDF417 are only available
on the SF51 with PDF version.

Bluetooth Radio

Radio Type: Bluetooth Class 1 version 1.2
Frequency: 2.4GHz

Radio Data Rate: 721 Kbits per second
Communication Range

Host radio Class 1: 30.5 m (100 ft)

Host radio Class 2: 10 m (32.8 ft)

Features: Adaptive Frequency Hopping (ADF)
EV10 Scanner

Scan rate: 200 scans per second

Scan range: up to 50 cm (19.7 in)

Scan angle: 40 degrees

Minimum X dimension: 4 mils (0.1 mm)
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Accessories for the SF51

You can use these accessories (sold and ordered separately) with
the SFS1. To order accessories, contact your local Intermec sales
representative.

Accessory

1-Bay Charger

1-Bay Charger
Power Supply

4-Bay Charger

4-Bay Charger
Power Supply

USB Bluetooth
Adapter

RS-232
Bluetooth
Adapter

Forearm Holster

Chest Strap
Holder

Industrial belt
clip holder
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Description

The 1-bay charger (Model 074645) charges the battery in
the SF51 and is designed to be mounted on a horizontal or
vertical surface.

The power supply for the 1-bay charger (P/N 851-086-xxx)
provides AC power to the 1-bay charger. It comes with
power supply adapters for Australia, Continental Europe,
United Kingdom, North America, Central America,
Mexico, and Japan. It also comes with a flat plate for use
with an AC power cord. The AC power cord is not included.

The 4-bay charger (Model 074646) has the same
functionality of the 1-bay charger, except it allows you to
charge up to four SF51 scanners at the same time.

The power supply for the 4-bay charger (P/N 851-088-xxx)
provides AC power to the 4-bay charger.

The USB Bluetooth Adapter (P/N 203-771-xxx) provides
wireless communications to your host computer and data
collection application.

The RS-232 Bluetooth Adapter (P/N 203-768-xxx) provides
wireless communications to your host computer and data
collection application through an RS-232 serial port on
your PC.

The forearm holster (P/N 074649) provides you with an
easy way to carry the SF51 when you are not using it. The
holster supports either right-handed or left-handed use.

Use the chest strap holder (P/N 825-173-xxx) to carry the
SF51 when you are not using it.

Use the belt clip (P/N 825-172-xxx) to carry the SF51 when
you are not using it.
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Symbols
1dr, firmware upgrade file 27

Numerics
1-bay charger
accessory, described 56
power supply, accessory,
described 56
4-bay charger
accessory, described 56
power supply, accessory,

described 56

A
accessories, described 56
Administrator Reset Factory
Defaults
bar code 25, 26

command 38

aim, Trigger Mode, described 50

audio feedback. See beeps
autostand, Trigger Mode,
described 50

B

bar code symbologies
Codabar 41
Codablock A 41
Codablock F 41
Code 11 41
Code 128 / EAN 128 42
Code 39 41
Code 93/93i 41
EAN.UCC Composite 44
Interleaved 2 of 5 45
ISBT 128 42
Matrix 2 of 5 45
Micro PDF417 45
MSI 45
PDF417 45
Plessey 46
RSS 14 46
RSS Expanded 46
RSS Limited 47
Standard 2 of 5 47
Telepen 48
TLC 39 49
UPC/EAN 51

bar codes
scanning

how to 7
troubleshooting 27

setup sheet, described 18
supported symbologies 55
symbologies, default 7
battery
charger
1-bay charger, described 56
4-bay charger, described 56
charging 3
checking status 3
using 2
Beep Duration command 38
Beep Frequency command 38
Beep Volume command 39
beeper, turning off 7
beeps, understanding 6
belt clip, accessory, described 56
blue lightSee Intermec Ready-to-
Work indicator 5
Bluetooth
adapter
accessory, described 56
installing 14
communications
configuring 21
host PC, connecting to 14
troubleshooting 25, 26
Connect/Disconnect
command 39
Device Name command 39
Device Page command
described 39
how to find your SFS1 30
Discoverable command 39
host devices supported 12
PIN
command 40
forgot, troubleshooting 26
security, configuring 22
Profile command 40

radio
communication
configuring 21
range 55

specifications 55
Security command 40
SF51 Bluetooth address
how to get 24
illustration 12
Bluetooth Device Disconnect, bar
code 14

button, scan, illustration 2
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calling Product Support 24
charger
1-bay charger, described 56
4-bay charger, described 56
charging, battery 3
chest strap holster, accessory,
described 56
ChinaPost, Matrix 2 of S setting,
described 45
cleaning, scanner window 31
Codabar command 41
Codablock A command 41
Codablock F command 41
Code 11 command 41
Code 128 / EAN 128 command
described 42
function codes, described 42
GTIN Processing for EAN 128
42
ISBT 128 42
Code 39 command 41
Code 93/93i command 41
collecting data, how to 18
commands. See configuration
commands
communication range, Bluetooth
radio 55
computers, Bluetooth supported
12
configuration commands
Administrator Reset Factory
Defaults 38
Beep Duration 38
Beep Frequency 38
Beep Volume 39
Bluetooth Connect/
Disconnect 39
Bluetooth Device Name 39
Bluetooth Device Page 39
Bluetooth Discoverable 39
Bluetooth PIN 40
Bluetooth Profile 40
Codabar 41
Codablock A 41
Codablock F 41
Code 11 41
Code 128 / EAN 128 42
GTIN Processing for EAN
128 42
ISBT 128 42
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Good Read LED Duration 44

Interleaved 2 of 5 45

ISBT 128 42

Matrix 2 of 5 45

Micro PDF417 45

MSI 45

PDF417 45

Plessey 46

Postamble 46

Preamble 46

RSS 14 46

RSS Expanded 46

RSS Limited 47

Setup Beep 47

Stacked Code Crackle 47

Standard 2 of 5 47

Symbology Identifier 47

Telepen 48

Timeout Between Different
Consecutive Codes 48

Timeout Between Identical
Consecutive Codes 48

TLC 39 49

Trigger Mode 49

Trigger Timeout 50

Turn Off After Good Read 50

UPC/EAN 51

GTIN processing 51
ISBN, described 51

User Reset Factory Defaults 51

using to configure the SE51 34

Vibrate Alert 52

Vibrate Alert Duration 52
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command 43
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Bluetooth communications 21
from Intermec computer 20
parameters 18
security 21
using EasySet 18
connecting to a host device
as a keyboard wedge 14
host PC 14
Intermec computer 13
overview 12
Consecutive Same Read Data
Validation command 43
continuous/edge, Trigger Mode,
described 49

D
Data Editing command 43
data transmission settings,
configuration commands,
list of 35
data, collecting 18
default configuration
restoring 20
values 35—38
dimensions, physical 54
Disable All Symbologies
command 43
disconnecting, how to 14
discoverable state
described 39

security, configuring 22

E
EAN 128, GTIN processing 42
EAN.UCC Composite command

EasySet
using to configure the SFS1 18
where to download 7

electrical specifications 54

Error Beep command 44

F
factory default settings, restoring
20
firmware
upgrading 28
version, how to get 24
FNC1, Code 128 / EAN 128
function code, described 42
FNC2, Code 128 / EAN 128
function code, described 42

forearm holster, accessory,
described 56

forgot Bluetooth PIN,
troubleshooting 26

G
Get Product Version bar code 24
Get SF51 Bluetooth Device
Address bar code 24, 25
Good Read
Beep
Duration command 44
Number command 44
Timing command 44
LED Duration command 44
green light. See status light
GTIN processing
EAN 128 42
UPC/EAN 51

H

holster, accessories, described 56
humidity, specifications 54

|
Interleaved 2 of S command 45
Intermec
computer
connecting to 13
supported 12
using to configure SF51 20
contact information ii
Ready-to-Work indicator
described 5
illustration 5
ISBT 128 command 42

K
keyboard wedge
collecting data 18
Keyport Bluetooth
connecting 15
described 14
Keyport Lite
connecting 16
described 14
troubleshooting 27

L

labels, bar code, scanning 7

level, Trigger Mode, described 49
lights
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blue. See Intermec Ready-to-
Work indicator

Intermec Ready-to-Work
indicator, described 5

understanding 5

limited discoverable
bar code 22
described 40

M
Macro PDF417, described 46
magnetic connector, illustration 2
Matrix 2 of S command
ChinaPost 45
described 45
Micro PDF417 command 45
MSI command 45

0

off, turning off the SF51 4

on, turning on the SE51 4

operating the SF51
humidity range 54

temperature range 5

p
paging the SFS1, how to 30
parameters, configuring SF51 18
PDF417 command 45
physical
dimensions 54
specifications 54
Plessey command 46
Postamble command 46
power down bar code 4
power specifications 54
power supply

1-bay charger, accessory,
described 56
4-bay charger, accessory,
described 56
Preamble command 46
problems, finding and solving 25
Product Support, calling 24
product version, how to get 24
pulse, Trigger Mode, described 50

R
radio
communications, configuring
21
specifications 55
Ready-to-Work indicator
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RS-232 Bluetooth adapter. See

Bluetooth adapter

RSS 14 command 46
RSS Expanded command 46
RSS Limited command 47

S
Scan button
illustration 2
scanner window, cleaning 31
scannerSee SF51 2
scanning
bar codes
described 7
how to hold the SF51 8
troubleshooting 27
security
Bluetooth PIN 22
configuring 21
discoverable state 22
Serial port profile, Bluetooth
configuring 40
described 21
disconnecting 14
resetting the SFS51 31
settings, restoring default 20
Setup Beep command 47
SF51
Bluetooth address
how to get 24
illustration 12
cleaning 31
configuring 18
connecting to a host device
as a keyboard wedge 14
host PC 14
Intermec computer 13
overview 12
description 2
firmware
upgrading 28
version, how to get 24
how to turn on 4
paging using Bluetooth Device
Page command 30
product version, how to get 24
resetting 31
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scan engine, specifications 55
sub-system version, how to get
24
turning off 4
turning on
upgrading 28
using to scan bar codes 7
with PDF version
bar code symbologies
supported 55
default bar code
symbologies 7
sounds. See beeps
specifications
electrical 54
humidity 54
power 54
radio, Bluetooth 55
scan engine 55
temperature 54
SPP. See Serial port profile,
Bluetooth
Stackezl Code Crackle command
7
Standard 2 of 5 command 47
status
beeps 6
checking battery 3
light
illustration 5
sub-system version, how to get 24
symbologies, bar code
default 7
list of 36
supported 55
Symbology Identifier command

T

Telepen command 48

temperature, specifications 54

Timeout Between Different
Consecutive Codes
command 48

Timeout Between Identical
Consecutive Codes
command 48

TLC 39 command 49

Trigger Mode command 49

Trigger Timeout command 50

troubleshooting

Bluetooth PIN, forgot 26
cannot establish a Bluetooth

connection 25, 26
keyboard wedge mode 27
lost Bluetooth connection 25
resetting the SF51 31
scanning 27

Turn Off After Good Read
command 50

turning off the SF51 4

turning on the SF51 4

U
understanding
beeps 6
lights 5
UPC/EAN command 51
GTIN processing 51
ISBN 51
upgrading, SF51 28
USB Bluetooth adapter. See
Bluetooth adapter
User Reset Factory Defaults
command 51

\'}
Vibrate Alert
command, described 52
described 8
turning off 9
turning on 9
volume, adjusting 39

w

wedge, keyboard. See keyboard
wedge

wireless communications,

configuring 21
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